
BOS og BridgeTablets - NØDDEKNÆKKEREN 

C:\Users\eyapr\Desktop\Bridge\BOS-Nøddeknækker\BOS Nøddeknækker - ver. 0.1.0.docx  
2024.12.31  10:13 

BOS - Bridge Organizing Software 

BridgeTablets 

 

NØDDEKNÆKKEREN 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Bridge Skolen 

Furesø Bridge, Januar 2025  



BOS og BridgeTablets - NØDDEKNÆKKEREN 

BOS Nøddeknækker - ver. 0.1.0.docx   2024.12.31  10:13  

INDHOLD  

1. INTRODUKTION .................................................................................................. 1 

1.1. Formål ...................................................................................................................................... 1 

1.2. Struktur..................................................................................................................................... 1 

1.3. Anvendt Notation ...................................................................................................................... 1 

2. BOS - DOKUMENTATION ...................................................................................... 2 

2.1. BOS - Anvendelse ...................................................................................................................... 2 
2.1.1. Generelt ............................................................................................................................................. 2 
2.1.2. BOS Update check .............................................................................................................................. 2 
2.1.3. Support fra Jannersten....................................................................................................................... 2 
2.1.4. BOS-BridgeTab procedurer ................................................................................................................ 3 

3. SYSTEMSAMMENHÆNGE .............................................................................. 4 

3.1. BOS-programkomponenter ........................................................................................................ 4 

3.2. Kommunikationsveje ................................................................................................................. 7 
3.2.1. Router – WiFi netværk ....................................................................................................................... 8 
3.2.2. Licenser .............................................................................................................................................. 8 
3.2.3. IP-adresse ........................................................................................................................................... 8 

3.3. Datalagring................................................................................................................................ 9 
3.3.1. Kortfordelingsfiler ............................................................................................................................ 10 
3.3.2. Navne ............................................................................................................................................... 10 
3.3.3. Skifteplaner (movements) ............................................................................................................... 10 
3.3.4. Turneringer ...................................................................................................................................... 10 

3.4. Dataregistrering ...................................................................................................................... 11 
3.4.1. Principdiagram - spillere .................................................................................................................. 11 
3.4.2. Datalagring ....................................................................................................................................... 13 
3.4.3. Fejlretning ........................................................................................................................................ 13 

4. NØDDER ...................................................................................................... 15 

4.1. Tablets .................................................................................................................................... 15 
4.1.1. Tablets kan ikke startes – generelt .................................................................................................. 15 
4.1.2. Tablet(s) kan ikke startes – enkelte tablets ..................................................................................... 15 
4.1.3. Start virker ikke så bordnummer kan ikke indtastes ....................................................................... 15 
4.1.4. Ikonet for netværksforbindelse er gult (og ikke grønt) ................................................................... 15 
4.1.5. Resultater registreret forkert/mangler registrering på tablets ....................................................... 16 
4.1.6. Kommunikation med PC fra tablets virker ikke ............................................................................... 16 
4.1.7. Spillernavne vises ikke på tablets .................................................................................................... 17 
4.1.8. Tablets kræver PIN-kode for at kunne registrere resultater ........................................................... 17 
4.1.9. Der anvendes små font-størrelser på nogle skærmbilleder ............................................................ 17 
4.1.10. Deaktivering af en ’låst’ APP på tabletten ....................................................................................... 17 
4.1.11. Lukning af BridgeTabs ...................................................................................................................... 17 

4.2. BTSC - Bridge Tablet Scorer Control på PC-en ............................................................................ 18 
4.2.1. PIN koder .......................................................................................................................................... 18 
4.2.2. Spiller ID registreret forkert på tablets ............................................................................................ 18 
4.2.3. Retning af fejlindtastninger for vilkårligt kortdæk, runde og bord på PC i BTSC ............................. 18 
4.2.4. Enkelte kort placeret ”forkert” i kortmappen (e.g. 13-12-13-14) .................................................... 18 
4.2.5. Lukning af BTSC – BridgeTab Scoring Control .................................................................................. 18 

4.3. EBUscorer/Pairs Program på PC-en .......................................................................................... 18 
4.3.1. Skifteplanen skal ændres ................................................................................................................. 18 
4.3.2. Generering af REPORTS .................................................................................................................... 18 

4.4. BOS ......................................................................................................................................... 19 



BOS og BridgeTablets - NØDDEKNÆKKEREN 

BOS Nøddeknækker - ver. 0.1.0.docx   2024.12.31  10:13  

4.4.1. Turneringen (<Event>) skal omdøbes .............................................................................................. 19 
4.4.2. Danske bogstaver vises forkert i Web-publish ................................................................................. 19 
4.4.3. Genoptagelse af en turnering .......................................................................................................... 19 

5. PROCESSER .................................................................................................. 20 

5.1. Opsætning af Tablets ............................................................................................................... 20 
5.1.1. Game Settings .................................................................................................................................. 20 

5.2. Spilstyring på Tablets ............................................................................................................... 21 
5.2.1. Skærmbilleder - Spilstyrere .............................................................................................................. 21 
5.2.2. Nulstilling af Tablets ......................................................................................................................... 23 
5.2.3. Brug af tvungen IP-adresse på Tablets............................................................................................. 23 
5.2.4. Reaktivering af Spillernavne-visning på tablets ............................................................................... 24 
5.2.5. Reaktivering af WiFi forbindelsen til routeren ................................................................................ 24 
5.2.6. Udskift tablets .................................................................................................................................. 24 
5.2.7. Gensend Resultater .......................................................................................................................... 25 

5.3. Retning af fejlindtastninger ..................................................................................................... 26 
5.3.1. Retning af fejlindtastninger i pågående runde på tabletter ............................................................ 26 
5.3.2. Retning af fejlindtastninger i tidligere runder – samme bord på tabletter ..................................... 26 
5.3.3. Retning af fejlindtastninger for vilkårligt kortdæk, runde og bord på PC i BTSC ............................. 28 
5.3.4. Retning af fejlplacering af enkelte kort i kortmapperne.................................................................. 30 
5.3.5. Retning af fejlindstastninger for Spiller ID ....................................................................................... 31 

5.4. Danske bogstaver i Web-publicerede resultater ....................................................................... 31 
 

 

BILAG 

[ 1 ] BOS: Reopen Event Results file 

 

 



BOS og BridgeTablets - NØDDEKNÆKKEREN 

BOS Nøddeknækker - ver. 0.1.0.docx 1/32 
2024.12.31  10:13 

1. INTRODUKTION 

1.1. Formål 
Dette hæftet er udarbejdet som en opslagsbog til brug for spilstyrere, når de løber ind i problemer med 

turneringsafvikling ved brug af  

- BOS og  

- Bridge Tablets 

1.2. Struktur 
For at skabe en systematisk oversigt er følgende struktur anvendt: 

BOS dokumentation 

Henvisninger til on-line manualer for BOS’ forskellige bestanddele. 

Systemsammenhænge 

Oversigter og beskrivelser af kritiske sammenhænge i opbygningen af BOS + Bridge Tablets systemerne, så 

man kan forstå, hvilket problemkompleks man evt. står overfor 

Nødder (problemerne / fejlene)  

Nødder listes sammen med en kortfattet beskrivelse for hurtigt at kunne finde fremt til, hvilket problem man 

står overfor. Der henvises også til beskrivelsen af systemsammenhænge, hvis disser er væsentlige for at 

identificere og rette fejlen. Endelig henvises der til de processer, som kan anvendes for de enkelte dele af 

fejlsøgningen og fejlretningen 

Processer for at udbedre/rette specifikke fejl 

To-do beskrivelser af de processer som skal udføres for at rette/kompensere for en given fejl. 

1.3. Anvendt Notation 
Notationen er bestræbt at følge disse regler: 

- <event> indsættes i tekst, hvor spilstyreren selv skal indsætte navnet på en 

 turnering  (som BOS kalder et event, kan f.eks være 24.12.24-A) 

 

- Italic bruges for navne på programmer, tastenavne, begreber, etc. 

 

- TD Menu > Resend Results bruges for en sekvens af tastetryk, adskilt af ”>”-tegn,  

 hvilket er en forkortet måde at skrive en række aktioner på 

 

- Fed lejlighedsvis fremhævning af f.eks. navne, ..... 
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2. BOS - DOKUMENTATION 
BOS er acronym for Bridge Organizing Software. 

BOS er en paraply, hvorunder alle nødvendige programmer for at gennemføre bridge-turneringer styres og 

afvikles, således at systemet varetager alle udvekslinger af data mellem de enkelde programdele. 

 

BOS systemet har to hovedformål: 

- Sikre at alle filer i systemet, som relaterer til en turnering/<event>, ikke bliver blandet sammen med 

filer tilhørende andre turneringer/<events>; 

- Være rammen for at udføre alle computer opgaver/funktioner, der behøves for at definere, 

forberede, gennemføre, analysere og publicere data om en bridgeturnering/bridge<event>. 

2.1. BOS - Anvendelse 

2.1.1. Generelt 
En detaljeret gennemgang af, hvordan turneringer afvikles med brug af BOS, vil blive omfattende, hvorfor der 

henvises til on-line manualerne for de enkelte dele: 

- BOS-X http://www.jannersten.com/Help/BOS-X/index.html 

- DupSoft http://www.jannersten.com/Help/DupSoft-X/ 

- BT Admin http://www.jannersten.com/Help/BT_Admin/ 

- Scorer Program https://www.ebu.co.uk/documents/ebuscore/manual.pdf 

 https://www.ebu.co.uk/ebuscore-wiki/ 

- Bridge Scorer Control http://www.jannersten.com/Help/BSC/ 

- Bridge Tablets  http://www.jannersten.com/Help/BT_app/index.html 

2.1.2. BOS Update check 
I BOS-Hovedmenuens bjælke vælges Help>Check for update, som så anviser den videre fremgangsmåde. 

2.1.3. Support fra Jannersten 
Bridge Skolen i Furesø Bridge har ikke oprettet en supportaftale med Jannersten.  

http://www.jannersten.com/Help/BOS-X/index.html
http://www.jannersten.com/Help/DupSoft-X/
http://www.jannersten.com/Help/BT_Admin/
https://www.ebu.co.uk/documents/ebuscore/manual.pdf
https://www.ebu.co.uk/ebuscore-wiki/
http://www.jannersten.com/Help/BSC/
http://www.jannersten.com/Help/BT_app/index.html


BOS og BridgeTablets - NØDDEKNÆKKEREN 

BOS Nøddeknækker - ver. 0.1.0.docx   2024.12.31  10:13 3 / 32 

Hvis en aftale oprettes og er aktiveret på Bridge Skolen’s Bridge Tab Dongle, så kan det ses i oversigten, der 

popper op, når Bridge Tab Admin startes i BOS. Supportaftaler er normalt gældende for eet år af gangen. 

2.1.4. BOS-BridgeTab procedurer 
Bridge Skolen har lavet en standard procedure for afvikling af en bridgeturnering, når der foreligger 

forblandede kort: 

 BOS-BridgeTab procedurer, forblandede kort – ver. 3.7.# 

Proceduren er lavet, så den omfatter lidt omstændelige fremgangsmåder, hvilket er gjort for at undgå at 

typiske fejlsituationer opstår.  

Når der så alligevel opstår problemer, er det håbet, at denne note kan være spilstyrerne til hjælp. 
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3. SYSTEMSAMMENHÆNGE 

3.1. BOS-programkomponenter 
I den følgende figur er  

 - gule bokse programmer, som indgår i BOS-organiseringen af en turnering 

 - orange bokse filer/foldere/databaser, som indeholder data 

 - grønne bokse eksterne enheder, der er tilsluttet PC-en, som kører BOS 
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Hovedaktiviteter under BOS: 

- DupSoft er et program til generering af tilfældigt blandede korthænder for et antal KortDæk, 

indlæsning og editering af KortDæk, samt gererering af digitale filer med information om KortDæk og 

dertil hørende mulige kontrakter og opnåelige stik. Desuden er der mulighed for at styre 

’duplikeringsmaskiner’, der fordeler de fysiske spillekort svarende til KortDæk (hænder/spil) 

genereret i programmet. Det er denne funktion, der har givet navn til programpakken. 

- Scoring Program er en tredjeparts programpakke, der holder styr på alle data vedrørende et 

<event>, herunder spillernavne, skifteplaner, kontrakter, udspil, spilleresultater, dommer-afgørelser, 

osv. Endvidere indeholder det faciliteter til Match-pointgivning og Rangordning af spillerne i en 

turnering, ligesom der ofte er omfattende rapporteringsfaciliteter. 

Bridge Skolen anvender et Scoring program, der er udviket af Jeffery Smith: PairsScorer. 

Programsystemet er nu overtaget og vedligeholdes af EBU-English Bridge Union og kaldes EBUscore 

og Bridge Skolen kan anvende underprogrammet for par-turneringer: Pairs. 

Scoring Programs er grundlæggende udviklet for manuel indtastning af spilleresultater og foretager 

på dette grundlag pointgivning og resultatbearbejdning. Elektronisk styring af spillet ved brug af 

skifteplaner og indsamling af spillernavne og spilleresultater er ikke integreret i Scoring Program, 

men varetages af et separat system (hvor BOS sørger for interfacestyringen mellem Scorer Program 

det elektroniske opsamlingsprogram). 

- Bridge Tab er et sådant elektronisk spilstyrings- og dataopsamlingssystem, som er udviklet specielt 

for BOS og som er det system, der anvendes af Bridge Skolen. I BOS systemet er der to programmer, 

som skal køre for at kommunikere med tablets:  

-  Bridge Tab Admin, der checker at licenserne for brug er tilstede og  

-  BTSC - Bridge Tab Score Control, der styrer kommunikationen til tablets og interfacet til Score 

Program. Se næste afsnit, hvor der er flere detaljer vedrørende udveksling af data mellem de 

enkelte programmer. 
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På næste figur er sammenhængen mellem de aktive programmer og deres igangsættelse illustreret:
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3.2. Kommunikationsveje 
De aktive systemkomponenter der er vigtige for kommunikationen er vist i figuren nedenfor: 
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3.2.1. Router – WiFi netværk 
Trådløs kommunikation bliver etableret gennem routere: 

- DLINK routeren (hvide cylinder) bruges til kommunikation mellem Tablets og PC gennem forbindelsen 

dlink-507C.  Der er ingen Internetforbindelse, når denne router er aktiveret 

- STIENS router bruges til kommunikation mellem PCen og Internettet gennem forbindelsen FUR-

Internet 

3.2.1.1. PC – Windows – WiFi 
På PCen vælges den ønskede WiFi forbindelse i Windows systemets settings: 

- dlink-507C når der skal komunikeres med tablets 

- FUR-Internet når der skal kommunikeres med Internettet 

3.2.1.2. Tablet – Setting – WiFi 
På tablets vælges den ønskede WiFi forbindelse i Settings: 

- dlink-507C for kommunikation med PC-en 

3.2.1.3. Internet - Web-Publish 
- Forbindelsen til Internettet etableres automatisk når FUR-Internet er aktivt 

3.2.2. Licenser 
Bridge Tablet Scorer Control programmet kræver, at der er gyldige licenser på PC-en for at fungere korrekt. 

BridgeTab Donglen har licenserne installeret og denne skal være monteret i PCen og Bridge Tab Admin skal 

være aktieret i BOS Hovedmenuen for korrekt funktion af BOS. 

3.2.3. IP-adresse 
Endelig skal både PC-en og Tablets anvende samme IP-adresse (192.168.0.153) for at kommunikere. 

På PC-en kan BT Admin’s IP adresse checkes i Bridge Tab Admin programskærmen. 

På tablets kan IP adressen sættes i TD Menu > BT Admin’s IP 
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3.3. Datalagring 
Grundlæggende er der tre dele af BOS, som hver især har egne systemer for lagring af (den samme) data: 

 - EBUscore Pairs 

 - BTSC – Bridge Tablet Score Control på PC-en 

 - BT App på tablets 

som vist i nedenstående figur: 
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Scorer programmet EBUscore Pairs lagrer alle sine data i tekst- eller databasefiler i samme folder som 

sourceprogrammet ligger i:  C:\BOS\EBUScore\Pairs. 

Bridge Tablet Scorer Control programmet lagrer sine tekst- og databasefiler i en folder med samme navn som 

turneringen:  <Event> . Folderne for alle turneringer afviklet med BOS er samlet i folderen: C:\BOS\Events. 

En undtagelse er den fil som indeholder alle navne på deltagere i Bridge Skolen: names.txt, der er placeret i 

samme  folder som BTSC-exe-filen:  C:\BOS\BridgeScorer. 

Groft sagt er det de selv samme  data, som lagres af begge systemer på PC-en.  

Del del af alle data, som vedrører netop det bord, hvorpå en bestemt tablet er placeret for registrering af 

spilledata, fordeles til BT App’s databaser af Bridge Tablet Scoring Control programmet. Strukturen af disse 

databaser er ikke kendt.  

3.3.1. Kortfordelingsfiler 
Når kortfordelingsfilen importeres i BOS lagrer DupSoft programmet kortfordelingen i fire filer med forskelligt 

format (<event>.dlm, <event>.dup, <event>.kbl, <event>.pbn), men med samme indhold.  

Disse filer lagres i folderen: C:\BOS\Events\<Event> \DATA. 

EBUscore Pairs lagrer kun kortfilerne, hvis dette aktivt tilvælges (ikke undersøgt/brugt). 

3.3.2. Navne 
BOS lagrer alle deltagernavne i filen:  C:\BOS\BridgeScorer\names.txt 

EBUscore Pairs lagrer alle deltagernavne i databasen C:\BOS\EBUScore\Pairs\PSMembers.dat 

3.3.3. Skifteplaner (movements) 
Alle standard skifteplaner/spilleplaner, der stilles til rådighed af EBUScore Pairs, findes i filen: 

C:\BOS\EBUScore\Pairs\PSMovements.txt  

Alle skifteplaner/spilleplaner, som er udviklet for Bridge Skolen, findes i filen: 

C:\BOS\EBUScore\Pairs\PSUserMovements.txt 

Den skifteplan (movement), som bliver valgt til en turnering læses automatisk over i bws-databasefilen 

<Event>.bws, der lagres i BOS’ datarepository: C:\BOS\Events\<Event>\DATA\<Event>.bws.  

Bemærk at denne bws fil bruges til at overføre data mellem BTSC og EBUscore Pairs, hvorfor begge 

programmer kan både skrive og læse i databasen. 

3.3.4. Turneringer 
EBUscorer Pairs lagrer alle informationer om de enkelte events (turneringer) i en enkelt databasefil: 

C:\BOS\EBUScore\Pairs\PSEvents.dat.  

Denne fil kan kun tilgås via EBUscorer Pairs skærmbilledet Event History. 

BOS (DupSoft, BTSC og logfiler fra Bridge Tab Admin) lagrer alle data vedrørende en enkelt turnering (<event>) 

i folderen: C:\BOS\Events\<Event> \DATA. 
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3.4. Dataregistrering 

3.4.1. Principdiagram - spillere 
Den række af aktiviteter, som spillerne oplever, er illustreret figuren nedenfor. Aktiviteterne er markeret med 

sorte bokse og rækkefølgen med røde pile. Aktiviteterne forbundet med spil af et enkelt KortDæk står i én 

søjle. De sorte rhomber nederst markerer en valgsituation, så hvis der er flere ikke spillede KortDæk i et 

KortSæt gentages aktiviteterne, mens man ellers går videre til at vise et resume for den spillede runde. Hvis 

der er flere runder, så vises flytteinformation inden en ny runde startes, mens der kan vises opsummeringer af 

turneringsresultaterne efter at alle runder er spillet. 

 

Registreringsforløb ved brug af BridgeTabs (viser kun 2 runder og 2 KortDæk i hver runde). 
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I næste figur er samme princip illustreret med engelsk tekst (som på tablets) og 

 - hvide kasser er aktiviteter for Tournament Director/Turneringsleder (opsætning) 

 - orange kasser er registrering af turneringsinformation 

 - gule kasser vedrører stilling of flytteanvisninger 

 - grønne kasser vedrører de enkelte spil i turneringen. 
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3.4.2. Datalagring 

3.4.2.1. Tablets 
Når bordnummeret er angivet for en tablet overføres alle skifteplanens data for det angivne bordnummer til 

tabletten.  

Såfremt Spiller ID er angivet for alle spillere i EBUscorer Pairs overføres disse Spiller ID-er og tilhørende navne 

til tabletten. Hvis Spiller ID indtastes på tabletten ved spillets start, findes de tilhørende navne på PC-en og alle 

navne fordeles til alle tabletterne. 

Derpå har alle tablets tilstrækkeligt med information til at gennemføre en hel turnering uden kontakt til PC-

en. 

Med en konstant opkobling til PC-en lagres data om kontrakter og resultater på tabletten og de overføres 

også omgående til PC-en. 

3.4.2.2. Bridge Tablet Score Control 
Bridge Tablet Scorer Control opbevarer alle data for turneringen i databasen <event>,bws. 

Information om skifteplanen er overført fra EBUscorer Pairs. Navne er enten overført fra EBUscorer Pairs – 

alternativt er Spiller ID angivet ved tablets og navne er hentet fra navnefilen names.txt. 

Alle kontrakter og resultater modtages fra tablets og lagres i <event>.bws, ligesom disse overføres til 

EBUscorer Pairs’ database PSEvent.dat. 

3.4.2.3. EBUscorer/Pairs 
Alle data vedrørende <event> gemmes i databasen PSEvent.dat 

3.4.3. Fejlretning 
Opstår der fejl i indateringen af data er, der som beskrevet i afsnit 4.1.5 Resultater registreret forkert/mangler 

registrering på tablets, 3 måder at gøre dette på: 

- Rettelse af fejl i registreringen i indeværende runde kan rettes umiddelbart af spillerne ved bordet, 

hvilket er markeret i nedenstående figur med en blå ramme og blå tekst, se afsnit 5.3.1 Retning af 

fejlindtastninger i pågående runde  

- Rettelse af fejl i registreringen i een af de foregående runder ved samme bord kan foretages af TD – 

Tournament Director/Turneringsleder på tabletten, hvilket er indikeret i nedenstående figur med en 

grøn ramme og med grøn tekst, se afsnit 5.3.2 Retning af fejlindtastninger i tidligere runder – samme 

bord 

- Rettelse af alle fejl i registreringerne i alle runder og ved alle borde kan også foretages af TD – 

Tournament Director/Turneringsleder i BTSC skærmbilledet på PC-en, hvilket er indikeret i 

nedenstående figur med en lilla ramme og med lilla tekst, se afsnit 5.3.3 Retning af fejlindtastninger 

for vilkårligt kortdæk, runde og bord 
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4. NØDDER 

4.1. Tablets 

4.1.1. Tablets kan ikke startes – generelt 
Hvis klargjorte tablets ikke kan starte kommunikationen til BTSC på PC-en kontrolleres det, at 

kommunikationskæden (se afsnit 3.2 Kommunikationsveje) er etableret og intakt. 

- Dlink routeren er tilsluttet og tændt 

- WiFi forbindelsen på PC-en er etableret til dlink-507C netværket 

- BridgeTab donglen er sat i et USB-stik på PC-en 

- Bridge Tab Admin er aktiveret i BOS Hovedmenuen 

- Bridge Tab Admin>View>BT Admin’s IP anvender IP adressen 192.168.0.153 

- I BTSC programmet er kommunikationen startet 

- WiFi setting på Tablets er indstillet til dlink-507C netværket 

- Reset tablet TD menu> New Game  

- BridgeTab Admin’s IP> Search og forbinder til PC-en 

ellers Enter IP Manually   (192.168.0.153) 

4.1.2. Tablet(s) kan ikke startes – enkelte tablets 
Hvis kun en enkelt eller få tablets ikke kan forbindes til PC-en kan det skyldes at Tabletten af sig selv har 

skiftet netværk til det eneste åbne netværk i Stien: FUR Internet 

- Gå til Settings på Tabletten og aktiver FUR Internet 

- Hold en finger på ikonen for FUR Internet forbindelsen, indtil en pop-up boks giver mulighed for at 

glemme dette netværk. Tast Glem.  

- Vælg derefter dlink-507C netværket og vend tilbage til Bridge Tab App’en. 

Såfremt dette ikke er nok til at få tabletten startet og forbundet kan man 

- Slukke tabletten helt og genstarte den 

- Starte Bridge Tab App’en 

Hvis der stadig ikke er oprettet forbindelse til PC-en bruges en anden tablet. 

4.1.3. Start virker ikke så bordnummer kan ikke indtastes 
På enkelte tablets (især mærket med #1 og #2) starter Bridge Tab App’en ikke, så Bordnummeret kan angives . 

Tit er det afhjulpet ved at slukke tabletten helt og derpå genstarte den med App-en: BridgeTab kørende (når 

der kommer en fejlmeddelelse, skal man altså bare slukke og tænde).  

Det tager lidt tid, så det er en god praksis at aktivere tablets med angivelse af Bordnumre ”i god tid”, inden de 

skal fordeles til spillebordene, så der er lidt tid til denne ’lille øvelse’ om nødvendigt.  

4.1.4. Ikonet for netværksforbindelse er gult (og ikke grønt) 
Se afsnit 5.2.1.1 nedenfor Netværksforbindelse vedrørende WiFi ikoner på tabletterne 

Det forventes, at WiFi ikonet øverst til venstre på tablettens skærm skal være grøn for at tabletten er klar til 

Start. 

Det er dog erfaret, at tabletten ofte er klar til Start selv om WiFi ikonet er gult. Prøv selv. 
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4.1.5. Resultater registreret forkert/mangler registrering på tablets 
Når et inddatering og/eller et resultat er indtastet forkert i systemet er der tre forskellige muligheder for at 

rette op på dette: 

- Opdages fejlen under spillet  og fejlen vedrører spil i den igangværende runde ved bordet, kan 

spillerne selv rette fejlen på tabletten ved bordet (se afsnit 5.3.1 Retning af fejlindtastninger i 

pågående runde) 

- Opdages fejlen efter at runden er tilendebragt kan fejlen rettes på tabletten ved det bord hvor det 

fejlramte spil er gennemført. Da de berørte spillere ikke længere sidder sammen ved bordet, er det 

kun Tournament Director/Turneringsleder – TD, som kan rette fejlen på tabletten (se afsnit 5.3.2 

Retning af fejlindtastninger i tidligere runder – samme bord) 

- Alle fejl kan rettes i BTSC programmet på PC-en og dermed også kun af TD – Tournament 

Director/Turneringsleder (se afsnit 5.3.3 Retning af fejlindtastninger for vilkårligt kortdæk, runde og 

bord) 

Forskellen mellem disse situationer er søgt illustreret i afsnit 3.4.3 Fejlretning. 

4.1.6. Kommunikation med PC fra tablets virker ikke 
På PC-skærmen konstateres, at ikke alle forventede data er 

modtaget (gul eller rød markering for det aktuelle Bord og 

Runde nummer). 

Situationen bekræftes ved at åbne TD Menu > Results.  

Når resultater for spillede KortDæk er overført til PC-en 

markeres ikonen for KortDækket med grøn highlighting 

Er resultater for spillede KortDæk ikke overført til PC-en 

forbliver baggrunden i ikonet hvidt. 

 

 

Prøv om noget af det følgende løser problemet: 

- Aktivér Resend Results i TD Menu. 

- I BTSC – Bridge Tab Scorer Control skærmbilledet på PC-en – tryk Stop for kommunikationen og 

genstart kommunikatione ved at trykke Start (for at fjerne eventuelle dead-locks på PC-en). 

- På Tabletten åbnes Settings og Wifi deaktiveres (Off). Derpå genaktiveres WiFi (On) og det 

kontrolleres at tabletten forbindes til det rigtige WiFi-netværk (for at fjerne eventuelle deak-locks i 

tablettens kommunikationssoftware). 

- Aktivér Resend Results i TD Menu endnu en gang. 
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- Hvis det ikke lykkes at genstarte overførslen af data, så kan det blive nødvendigt 

at lave en TD menu>Replace, hvor en ny tablet knyttes til det aktuelle bord og 

manglende data indlægges manuelt. 

 

 

 

 

 

 

 

 

4.1.7. Spillernavne vises ikke på tablets 
Se afsnit 5.2.4 Reaktivering af Spillernavne-visning på tablets. 

4.1.8. Tablets kræver PIN-kode for at kunne registrere resultater 
Se afsnit 4.2.1 PIN koder. 

4.1.9. Der anvendes små font-størrelser på nogle skærmbilleder 
Der forekommer en sporadisk fejl på de nyeste tablets #32-#37, som bevirker at enkelts skærmbilleder vises 

med meget lille skriftstørrelse. Årsagen til dette er ikke kendt. 

Slukkes tabletten og genstartes er fejlen hidtil forsvundet. 

4.1.10. Deaktivering af en ’låst’ APP på tabletten 
- Den firkantede Icon nederst til højre på tablettens skærm aktiveres. Derpå vises alle kørende APPs 

- På nyere tablettter swipes opad på skærmen, hvorved visning af kørende APPs fremkommer. 

- Deaktiver APPs som ikke skal være aktive ved at trykke på ’krydset’ i øverste højre hjørne af billedet 

af APPen.  

- Hvis en APP er låst, hvilket vises med en ’lukket hængelås’ øverst i billedet af APPen, trykkes der blot 

på denne hængelås, hvorved APPen låses op og derpå kan den slettes ved at trykke på ’krydset’. 

4.1.11. Lukning af BridgeTabs 
- Check at resultater af alle spil er overført til PC-en (BTSC-programmet) 

- Hvis det ikke er tilfældet, så  

Forsøges med Resend Results (der kan findes i TD Menu) 

Ryk evt tabletten tættere på Routeren 

Stop og Start efterfølgende igen kommunikationen mellem PC-en og tablets i BTSC 

(det har undertiden virket) 

Sluk WiFi-forbindelsen på tabletten og genstart den; derpå Resend Results (har tit virket). 

- Mislykkes overførslen af data skal de manglende resultater aflæses på tablets og indtastes manuelt i 

BTSC 

- Når man har sikret sig, at alle data er registreret i BTSC, lukkes BridgeTab-APPen på tablets. 

Det sker ved at trykke på ”firkanten” nederst på skærmen og derpå trykke på ”krydset” i øverste 

højre hjørne af den lille ikon med BridgeTab-APPen, der dukker op. Det sikrer at BridgeTab-APPen 

kan genåbnes og man kan få adgang til data fra sidste spil (i nødsituationer); 

- Tablets kan slukkes, når man successfuldt har publiceret resultater på Web-en og åbnet de 

Rapporter, som er interessante. 
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4.2. BTSC - Bridge Tablet Scorer Control på PC-en 

4.2.1. PIN koder 
Hvis der ved et uheld er indtastet en PIN-kode for en tablet, kan spilstyreren i BTSC-vinduet på PC-en via 

View>PIN Codes åbne en fil, hvor alle aktuelle PIN-koder fremgår – både for TD og spillere. 

4.2.2. Spiller ID registreret forkert på tablets 
Når et Spiller ID er angivet forkert for een eller flere spillere, rettes dette lettest i BTSC skærmbilledet, se 

afsnit 5.3.5 Retning af fejlindstastninger for Spiller ID.  

4.2.3. Retning af fejlindtastninger for vilkårligt kortdæk, runde og bord på PC i BTSC 
Under spillet eller umiddelbart efter afslutningen kan registreringerne for de enkelte spil checkes ved i BTSC 

vinduet at klikke på feltet for det aktuelle bord og runde. Herved popper der et gult vindue op, hvor de 

registrerede resultater fremgår for hvert spil, se afsnit 5.3.3 Retning af fejlindtastninger for vilkårligt kortdæk, 

runde og bord på PC i BTSC. 

Alternativt kan man åbne Results skærmbilledet via  

View>Results per Board og inddatere/rette her.  

Det er dog noget mere besværligt, idet man skal navigere rundt mellem de forskellige Boards, hvilket undgås 

med den første metode beskrevet ovenfor. Syntaxen for inddatering er som vist ovenfor. 

4.2.4. Enkelte kort placeret ”forkert” i kortmappen (e.g. 13-12-13-14) 
Er et kort lagt forkert tilbage i en kortmappe kan indholdet i mappen checkes mod kortfordelingsfilen, hvilket 

lettest gøres i BTSC skærmbilledet, se afsnit 5.3.4 Retning af fejlplacering af enkelte kort i kortmapperne. 

4.2.5. Lukning af BTSC – BridgeTab Scoring Control 
- Check at resultater fra alle spil er registreret (alle felter i matricen på skærmen er grønne) 

- Check at alle spillere har registreret sig (View>Player Names) 

- Check at eventuelle dommerafgørelser er blevet registreret 

- Tast Stop vedrørende kommunikationen mellem PC og tablets 

- File>Web Publish (dette skal gøres, uanset at der kan forekomme fejl med danske bogstaver, da 

denne operation i BTSC samtidig genererer en fil, results.txt i <event>-folderen. Denne fil er 

nødvendig for at kunne gen-publicere på Web-en efter at have rettet danske bogstaver – se afsnit 

5.4 Danske bogstaver i Web-publicerede resultater) 

- Luk BTSC-programmet File>Quit 

4.3. EBUscorer/Pairs Program på PC-en 

4.3.1. Skifteplanen skal ændres  
Hvis man ved turneringens start erkender at skifteplanen skal ændres står man med 

- Indlæste kortfordeliingsfiler, som stadig kan bruges 

- En <event>.bws fil som er opdateret med forkerte data om skifteplanen 

Derfor må man gå tilbage i processen således: 

- Stop kommunikationen med tablets i BTSC vinduet 

- I BTSC File>Quit 

- I Table Top Unit Database skærmbilledet tast Restart og gå ud af skærmbilledet ved at taste Return  

- I Event Menu Startes forfra med Select Movement 

- Færdiggør opsætningen som normalt 

4.3.2. Generering af REPORTS 
- I Event Menu åbnes rapporteringsværktøjet ved at taste Reports 
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- I Print Menu vælg Club Print 

- I Print to vælges et passende fil-format for dit output – f.eks. xls  

- Aktiver Display on Screen, der vil generere en rapport til visning på skærmen, men samtidig 

genereres en tilsvarende fil i <event>-folderen, så der efterfølgende er let adgang til dokumentation 

af turneringen. 

- Tast Return, når du har genereret de ønskede rapporter 

4.4. BOS 

4.4.1. Turneringen (<Event>) skal omdøbes 
En turnering navngives som det første, når BOS startes: Create New Event.  

Navnet på turneringen refererer vi i denne note med betegnelsen <event>, som typisk er datoen efterfulgt af 

en tilføjelse, som markerer et formiddags- eller eftermiddagshold e.g. <event> = ”24-12-23-E”. 

<event> navnet indgår i foldernavne, stier til biblioteker, filnavne etc. Derfor kan man ikke ændre <event> 

navnet uden at ødelægge mange (ukendte?) referencer i BOS. 

Derfor skal man starte helt forfra, hvis der ønskes et andet navn for turneringen! 

4.4.2. Danske bogstaver vises forkert i Web-publish 
De resultater, som publiseres med Web-Publish funktionen i BTSC programmet, lagres i en datafil:  

 C:\BOS\Events\<event>\DATA\results.txt 

Denne datafil bruger et ANSI-dataformat. 

For at rette op på dette skal filens ændres til UTF-8 dataformat og resultaterne skal publiceres igen, se afsnit 

5.4 Danske bogstaver i Web-publicerede resultater. 

4.4.3. Genoptagelse af en turnering 
Hvis en turnering (event) er blevet lukket ned og man senere ønsker at åbne denne turnering igen med alle 

data reinstalleret, så har Bridge Skolen lavet en kort vejledning, der angiver de forskellige trin i processen: 

BOS: Reopen Event Results file (se Bilag [1]). 

Når en turnering genoptages sker det ved, at udvekslingsdatabasen <event>.bws mellem BTSC-BridgeTab 

Scorer Control og Scoring Program – f.eks. Pairs – læses tilbage i systemet.  

For at arbejde videre med informationerne i databasen kræves det, at der er gyldige licenser tilgængelige for 

BOS svarende til antallet af borde, der indgår i spillet. For at dette kan opfyldes, så skal BT Admin være startet 

og der skal være en Bridge Tab Dongle i maskinen med det nødvendige antal gyldige licenser. 
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5. PROCESSER 

5.1. Opsætning af Tablets 

5.1.1. Game Settings 
Under opsætning af en turnering vælges tablets’ præsentationsmåde i Game Settings.  

                      

I boksen Presentation er der et par vigtige valg at gøre, vedrørende hvem der registrerer resultater og 

hvordan disse præsenteres.  

5.1.1.1. Registrering af spil-input – Nord eller Syd 
I præsentationvalgene har det været standard at vælge  Rotate compass directions (tick if N scores) hvorved 

Nord placeres nederst. 

Vælges  Rotate compass directions (tick if N scores) i stedet vil kompasretningerne blive fremstillet 

’naturligt’, med Syd placeret nederst. Derved placeres Vest til venstre og Øst til højre, hvilket er mere 

naturligt.  

 Rotate compass directions (tick if N scores):   Rotate compass directions (tick if N scores):  

                                    

5.1.1.2. Resultat for KortDæk 
I præsentationvalgene har det været standard at vælge  Points related to declarer. 

De spilpoint, der beregnes af systemet og vises, angives ifølge dette valg IKKE i forhold til kontratholderen, 

men i forhold til Nord-Syd. 
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Tickes der nu af i feltet  Points related to declarer vil samme meldinger og resultater vises således: 

 

 

 

 

 

 

 

 

 

Det er samme visning for Nord-Syd. Da pointene angives i forhold til declarer er Øst-Vest’s point nu positive, 

fordi de jo har vundet kontrakten.  

5.2. Spilstyring på Tablets 

5.2.1. Skærmbilleder - Spilstyrere 
Settings-knappen på startskærmen giver adgang til de 

faciliteter, som spilstyrerne kan få brug for i forbindelse 

med systemopsætningen, ombytning af tablets ved 

borde, og eventuelt rettelse af fejl eller indtastning af 

dommerafgørelser.  

Undervejs i spillet bruges et vedvarende tryk på ?-tasten 

(2-3 sek) for at komme til TD-menuen (Tournament 

Director/Turneringsleder). Se afsnit 5.2.1.3. 
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5.2.1.1. Netværksforbindelse 
Tabletten ved bordet skal kommunikere med Bridge Tab Admin / BTSC på PC-en ved start af turneringen. 

Grøn:  En grøn WiFi ikon i topbjælken viser, at der er kommunikationsforbindelse til Bridge Tab 

Admin på PC-en. Hvis det ikke er tilfældet må fejlen søges og rettes. 

Yellow:  Bridge Tab Admin er ikke fundet. Check at alt kører på PC-en. 

Erfaringen viser, at man bare skal ignorere den gule ikon og starte – tit virker det. 

Check også at hardware ID-nummeret er 5-cifret. Hvis ikke det er ok skal det resettes (se 

manual). 

Red-?:  Netværket er ikke korrekt. Brug samme netværk som PC-en bruger. 

 

Red-X:  Der er ikke tilsluttet noget netværk. Check at routeren fungerer. 

 

5.2.1.2. Settings 
Load Names anvendes kun hvis der er specielle udfordringer med fremmede 

karakterer i spillernes navne (f.eks. tyrkiske, kinesiske, ..). Bruges spillerdatabasen 

i Scoring Program er det næppe nødvendigt at anvende denne funtion. 

TD menu åbner TD-menuen (TD Tournament Director/Turneringeleder). 

Dummy Mode kan bruges til at træne brugen af Tablets. 

Rotate Screen – måske er det for at muliggøre at Syd inddaterer i stedet for Nord.  

Network giver adgang til Androids side for valg af network.  

Timeout indikerer hvor længe tabletten vil vente på f.eks. at få forbindelse via 

netværket til PC-en. Må ikke sættes for højt, da det ”låser”/sinker brugen af 

tabletten. 

 

5.2.1.3. TD menu 
BT Admin’s IP åbnes, hvis det er nødvendigt at ændre den fast kodede IP-adresse, 

der bruges af BT Admin på PC-en til at kommunikere med tablets.  Åbn på PC-en BT 

Admin>View>BT Admin’s IP for at checke IP-adressen brugt af PC-en. 

Resend Results kan aktiveres, hvis der ikke overføres data fra tabletten til PC-en. 

(Undertiden hjælper det på PC-en i skærmbilledet for BTSC at trykke Stop og Start 

for BTSC kommunikationen). Man kan checke om alle data er overført, ved at se 

om alle felter knyttet til det aktuelle bord er ’grønne’ i BTSC vinduet på PC-en. 

Replace anvendes hvis en tablet ikke fungerer og skal erstattes af en anden. 

Funktionen aktiveres på den nye tablet, der erstatter den tablet der ikke fungerer. 

New Game skal altid aktiveres umiddelbart før start af en ny turnering, idet alle 

”gamle” indtastninger herved slettes og tabletten er renset og klar til en ny 

turnering. 
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5.2.2. Nulstilling af Tablets  
Det har vist sig afgørende at alle tablets er nulstillet før en ny turnering startes. Dette omfatter to ting: 

- Tabletten skal ”glemme” alle åbne netværk i Stien:   FUR Internet 

Tabletten skal forbindes til det lokale netværk:    dlink-507C 

- Alle data slettes på tabletten og den gøres klar til Start 

Hvis Welcome to BridgeTab startskærmen ikke vises gøres følgende: 

- Hold ?-knappen øverst til højre nede indtil TD Menu vises 

- Tast New Game og derpå Resume.  

Nu skulle Welcome to BridgeTab-startskærmen helst stå på skærmen 

 

- Tast Settings 

- Tast Network 

- Vælg  netværket FUR Internet 

Når kontakten til dette netværk er etableret af 

tabletten holdes fingeren på det felt, hvor 

netværksforbindelsen vises. Nu popper en lille boks 

frem med valgmuligheder og der trykkes på GLEM. 

 

Denne forholdsregel sikrer tilsyneladende, at tabletten 

ikke så let finder på at søge efter alternative netværk 

(det er ikke dokumenteret, men det er en god erfaring) 

 

- Vælg nu netværket dlink-507C 

Når kontakter til dette netværk er etableret af tabletten, så forlades Settings>Networks menuen ved 

at trykke på venstrepilen i det nederste sorte felt på skærmen. 

- Tast igen Settings 

- Tast TD Menu 

- Tast New Game og tabletten vender automatisk tilbage til Start-skærmen 

Denne forholdsregel sikrer, at alle data fra tidligere turneringer slettes på tabletten – og den er dermed klar til 

at modtage informationer vedrørende den næste turnering. 

5.2.3. Brug af tvungen IP-adresse på Tablets 
- I Indstillinger>WiFi tilsluttes tabletten til Routeren dlink-507C. 

- TD menu > BT Admin’s IP 

- Indtast IP-adressen manuelt (i.e. 192.168.0.153) 

- Godkend IP-adressen ved at clicke på fluebenet 

- Accepter IP-adressen med den røde pil nederst til højre 

- Warning 

  ”Tablet will be forced to connect to IP-address” 

- Svar “YES” 

- TD menu > New Game 

- Warning 

“Tablet will be forced to Quit Active game” 

- Svar “YES” 
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5.2.4. Reaktivering af Spillernavne-visning på tablets 
Navne forsvinder fra Confirm Seating skærmen og i stedet vises Par-numre – se 

skærmbilledet til venstre. 

- Åbn TD menu > Names > Show Names og 

- Åbn for den aktuelle runde, hvor man så ser numrene igen. 

- Åbn for nogle af de foregående runder  

- Vend tilbage til den fejlbehæftede runde 

- Navnelisten er nu forhåbentlig opdateret og navnene vises korrekt igen 

Denne fremgangsmåde er ”ikke skudsikker”, men giver ofte det ønskede resultat. 

 

 

 

 

5.2.5. Reaktivering af WiFi forbindelsen til routeren 
Hvis der er mistanke om at WiFi forbindelsen fra tabletten til routeren (dlink-507C) er inaktiv og skal 

reaktiveres kan to forskellige fremgangsmåder være aktuelle: 

- Tabletten starter automatisk BridgeTab App’en op, når tabletter tændes: 

Dette sker, fordi man i TD Menu har aktiveret BT as home. Det besværliggør adgangen til 

Settings>Network, hvor WiFi forbindelsen skal reaktiveres.  

  Man må først deaktivere BT as home i TD Menu.  

  Derpå reaktiveres WiFi forbindelsen til dlink-507C i Settings>Networks  

  Man reaktiverer BT As home i TD Menu. 

- Tabletten starter ikke BridgeTab automatisk, når tabletten tændes: 

 Man reaktiverer WiFi forbindelsen til dlink-507C i Settings>Networks. 

5.2.6. Udskift tablets 
Opstår der manglende funktionalitet på en tablet, må det rettes så hurtigt som muligt.  

Hvis det ikke lykkes må tabletten udskiftes med en anden tablet:  TD menu > Replace. 

På den fejlbehæftede tablet: 

- I TD Menu > Results kontrolleres om alle indtastede resultater er sendt til PC-en: 

- KortDæk ikonet er ”gennemsigtigt grønt”, hvilket indikerer at resultatet for KortDækket  

  er sendt til PC-en. Det er ikke nødvendigt at gøre noget yderligeree for dette KortDæk. 

- KortDæk ikonet har ”hvid baggrundsfarve”, hvilket indikerer at resultatet for det aktuelle KortDæk 

  ikke er sendt til PC-en.  

- Ikke sendte Resultater noteres ned på et stykke papir. 

På den nye udskiftningstablet: 

- Start TD Menu > Replace. 

- Indtast den Sektion bordet tilhører. For små turneringer er det normalt A 



BOS og BridgeTablets - NØDDEKNÆKKEREN 

BOS Nøddeknækker - ver. 0.1.0.docx   2024.12.31  10:13 25 / 32 

 

- Indtast det Bordnummer, der skal have den nye tablet. 

- Accepter valget på skærmen 

- Alle registrerede data overføres fra PC-en til den nye tablet og den fejlbehæftede tablet deaktiveres 

i systemet (skærmbilledet viser stadig forbindelse til BOS, men det er forkert). 

- Ikke-sendte resultater registreres manuelt: 

- enten på PC-en i BTSC skærmbilledet  

- eller på tabletten i TD Menu > Results 

5.2.7. Gensend Resultater 

Tryk varigt på ? indtil TD Menu popper op. 

- Tast Resend Results 

- Tast Resume. 
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5.3. Retning af fejlindtastninger 

5.3.1. Retning af fejlindtastninger i pågående runde på tabletter 
Undervejs i spillet vises indtastninger vedrørende kontrakten og resultatet i 

bjælken øverst i skærmbilledet (se illustration til venstre). 

Er man kommet til at indtaste forkerte oplysninger, så kan spillerne selv trykke på 

den information øverst i skærmbilledet, som er forkert. Derpå ledes man tilbage 

til det sted i rækkefølgen, hvor den forkerte information blev indtastet og her kan 

man så i indtaste den korrekte information. Derpå fortsætter tabletten med den 

sædvanlige sekvens af skærmbilleder. 

På samme måde kan man i oversigten over spillene i 

den pågående runde også trykke på den 

information, som skal rettes, hvorpå det samme, 

som beskrevet ovenfor, indtræder. 

 

 

 

 

 

 

 

5.3.2. Retning af fejlindtastninger i tidligere runder – samme bord på tabletter 
Hvis en fejlindtastning i en færdigspillet runde opdages, så kan spillerne ikke selv 

rette fejlen. Det kan TD – Tournament Director/Turneringsleder. 

Her kan man på samme måde trykke på det fejlregistrerede resultat og rette det 

på de følgende skærmbilleder.  
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TDmenu > Results 

For det aktuelle bord vises alle de KortDæk, som skal spilles ved bordet. 

Ikonen for KortDækket er grønt markerer, at data er overført til Bridge Tabs Databasen 

Ikonen for KortDækket er hvidt markerer, at data IKKE er overført 

Ikonen for KortDækket er blå markerer, at der er en TD-afgørelse (Ruling) 

 

 

 

 

Ønskes et KortDæk’s resultater ændret/inddateret trykkes på KortDækkets ikon, der giver følgende 

muligheder: 

 Amend =  små justeringer 

Replace =  hele resultatet specificeres fra bunden 

Skip =  Ingen inddateringer 

%/%  =  TD-afgørelse 

AMEND: 

Amend giver mulighed for at ændre een eller flere parametre vedrørende resultatet. 

 

 

 

 

 

 

REPLACE: 
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SKIP: 

Intet input 

RULING: 

Check med Scoring Program hvorledes disse værdier tolkes/anvendes. 

 

 

 

 

 

 

 

 

Denne fremgangsmåde er lidt usikker, idet man skal have godt styr på, at det er de rette data, der ændres. 

Derfor anbefales det at gå til BTSC-skærmbilledet på PC-en og her foretage de ønskede rettelser – se næste 

afsnit. 

5.3.3. Retning af fejlindtastninger for vilkårligt kortdæk, runde og bord på PC i BTSC 
Under spillet eller umiddelbart efter afslutningen kan registreringerne for de enkelte spil checkes ved at klikke 

på feltet for det aktuelle bord og runde. Herved popper der et gult vindue op, hvor de registrerede resultater 

fremgår for hvert spil. 

Klikkes der på et bestemt spil åbner det muligheden for at rette resultatet. 
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Når man klikker på det spil, som skal rettes, noteres det, at det hvide felt ikke når hen til pts (points). Det er 

fordi systemet ”forbeholder sig ret til” selv at beregne de point, som kontrakten og resutatet berettiger. Det 

vises, når man har afsluttet med ’enter’. 

Syntax for inddatering eller rettelse af registrerede resultater:  

 

Resultater opsamlet på BridgeTablets og i BTSC-programmet på PC-en registreres i udvekslingsdatabasen 

Bridge Tab Database (<event>.bws), således at resultaterne også er tilgængelige i Scorer Programmet (e.g. 

EBUscorePairs). 

  

Cont
ra

ct

Dec
lar

er

Tr
ick

s w
on

Le
ad

 ca
rd

Point
s

Ex
plan

at
io

n

contr decl tricks lead pts

1S 1 Spade

2H 2 Hearts

4D 4 Diamonds

6C 6 Clubs

x Double

xx Redoble

3N 3 No Trumph

NP Not Played - SKIP

PASS Passes

N North

E East  

S South

W West

0, 1, … ,12, 13 Tricks won

CA Club Ace

D9 Diamond 9

DT Diamond 10

DJ Diamond Jack

DQ Diamond Queen

DK Diamond King

DA Diamond Ace
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Alternativt kan man åbne Results skærmbilledet via View>Results per Board og inddatere/rette her.  

Det er dog noget mere besværligt, idet man 

skal navigere rundt mellem de forskellige 

Boards, hvilket undgås med den første 

metode beskrevet ovenfor. 

Syntaxen for inddatering er som vist 

ovenfor. 

 

 

 

 

 

 

 

 

5.3.4. Retning af fejlplacering af enkelte kort i kortmapperne 
Hvis enkelte kort er lagt forkert tilbage i kortmapperne, kan fejlen rettes ved hjælp af følgende 

fremgangsmåde. 

I BTSC skærmbilledet klikkes i den øverste bjælke på teksten Show All Deals, hvorved DupSoft programmet 

startes.  

 

DupSoft viser kortfordelingerne. Man kan manøvrere mellem de enkelte kortdæk med de sorte pile i den 

øverste grå bjælke. 
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5.3.5. Retning af fejlindstastninger for Spiller ID 
I BTSC vinduet vælges View>Player Names 

Klikkes på et felt i kolonnen Member ID åbner et vindue, hvor en 

spillers ID-nummer kan indtastes (kaldes Player ID = PID i Player 

Database), ifald spilleren ikke har fået gjort dette ved opstarten af 

turneringen. Her kan også rettes, hvis indtastningen er fejlagtig. 

Angives et spillernummer, som allerede er brugt, vil systemet forsøge 

at ombytte placeringen af de to spillere. 

 

 

 

 

 

5.4. Danske bogstaver i Web-publicerede resultater 
I BOS version 10.30 dateret 2022.02.02 håndteres danske bogstaver æ, ø og å fejlagtigt, når der publiceres på 

Web-en. Fejlen opstår, fordi BOS skriver results.txt-filen ud i ANSI format og WebPublisher kræver  

input i UTF-8 format. 

Jannersten har sendt følgende work-around 2022.01.29: 

Regarding Danish names you should know that the results file must be in UTF-8. 
Do like this: 

1.   Choose Web publish in Bridge Scorer Control as usual.  
 This will publish the names wrongly but also create the results.txt file. 

2.   Open the results.txt file that you find in C:\BOS\Events\<Event name>\DATA\results.txt with Notepad.  
3.   Choose "Save as" and change the encoding from ANSI to UTF-8. 
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4.   Click the button "Web publish” in BOS’s main user interface. Your names will now show correctly. 

 

 

 

 

 

 

Det kan tilføjes, at lange navne i results.txt ofte kortes af.  

Man kan tilføje de manglende bogstaver i results.txt og stadig få pæne opstillinger på Web-en. 
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 BILAG [1] 

BOS:  Reopen Event Results file 

The sequence required to reopen an Event’s results file is listed below: 

- First start Bridge Tab Admin. 

Open the Event in BOS by clicking Shift & Start Scoring 

  

 

In the pop-up box select the Scoring Program (automatically highlighted) and 

start by clicking OK : 

A pop-up message will appear in reply – sometimes hidden behind the 

windows already on the screen: 
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Start the Scoring program by clicking Bridge Tab Scoring:  

 

 

 

 

 

 

 

 

This will start EBUscorePairs program. 

Press the Create Database button. 

 

Click the right option Resume existing session 1, which will force the system to apply the existing database for 

the selected Event rather that creating a new database. 
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Then start the BSC - Bridge Score Control program Bridge Tab Score Control by clicking the button Launch 

BTSC.  

 Be careful and read the pop-up box and click Yes. This will ensure that the data already in the database are 

maintained.  

 

Choose the relevant game settings and click Save.  
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The Bridge Tab Score Control program will now fill the internal results memory with data form the results 

database (<event.bws> file) 

However the results will not be transferred automatically to the EBUscorePairs program, and hence we have 

to manually do this by clicking two buttons: 

Read Names such that the players will be identified by the names given at the beginning of the Event on the 

Tablets 
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Read All Results such that results will be transferred from the database to the BSC control (EBUscorerPairs?). 

 

With this in place access is provided to all results from the Results tab. 
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For example the Ranks. 

 

2022.01.23 / EYA 

 


